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Introduction
Workshare Professional is a desktop application that automates managing changes to business documents, 
protects against unauthorized content disclosure and delivers the world’s most secure PDF creation, all in one 
integrated solution.

Workshare Professional is designed for the way that you work – within Microsoft Office. Workshare Professional 
integrates with your existing desktop productivity software Microsoft Word, Excel and PowerPoint and your 
email applications such as Microsoft Outlook or IBM Lotus Notes. In addition, many companies use Document 
Management Systems (DMSs) and/or Microsoft SharePoint to track and store key documents and Workshare 
Professional integrates out of the box with these.

Workshare Professional provides:

 Fast and accurate multi-party document review

 Elimination of version/master proliferation and confusion

 Fast and accurate document comparison including “one-to-many” comparison

 Policy-driven content risk management and PDF conversion

 Storage of attachments in the cloud

 Discovery and removal of hidden data and visible content leaks

 Ability for users to fix potential problems with manual redaction options 

 Secure PDF conversion anywhere and on email send

 Extended and secured document control over email and portals

 Accurate conversion of PDF files to Microsoft Word files

 Ability to combine multiple files into a single PDF

 Ability to generate a Redline (comparison) document from Microsoft Outlook

The Workshare Professional suite of products includes:

Workshare Compare The world’s leading and fastest comparison tool especially critical for complex 
business documents in any language with difficult to compare changes like tables, 
complex formatting, numbering and styles.

Workshare Protect Workshare's market leading and award winning client educates users as it enforces 
content security policy. Working both online and offline, the Workshare Protect client 
removes risky content, converts information to appropriate formats, and applies 
content rights. Workshare Professional also includes support for new Workshare 
server components that complement this advanced new Workshare Protect client.

Workshare Review The fast, accurate and secure way to review and exchange business documents. 
Workshare Professional Review eliminates version/master proliferation and confusion 
when sharing documents across email, portals, and document repositories and 
provides full document lifecycle audit and visibility.
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Workshare Professional Benefits and Features
Workshare Professional provides accurate and efficient review control, comparison, and security while 
automatically maintaining a single master document

 Advanced PDF and document comparison

Compare one document against multiple modified versions including Word to Word, PDF to PDF, and 
Word to text-based PDF.

 Advanced and trusted accuracy

Accurately compare complex documents (100+ pages) for changes in text, embedded excel tables and 
images.

 Document redlining made simple

Email redlines as tracked changes or save redlines as a PDF document.

 Multiple comparison interfaces

Utilize the standalone document comparison tool or work within Microsoft Word.

 Alert and Compare

Generate Redline documents from Microsoft Outlook

 Manage and track document reviews

Give authors, delegates and reviewers an easy means to assemble, review and verify document 
changes.

 Single master tracking

Ensure the correct version of a document is under review by colleagues, clients and partners regardless 
of where the document is stored.

 One click PDF creation

Create a PDF with one click when attaching a file to an email or from within Microsoft Office 
applications

 Edit and collaborate on PDF documents

Convert text-based PDF documents into Microsoft Word for editing

 Combine PDF

Combine multiple files into a single PDF.

 Convert and compare image-based documents

Convert and compare scanned documents, images and faxes when used with the Workshare OCR 
Server.

 Remove sensitive information

Ensure total cleanup and removal of all hidden electronic information with metadata removal and 
redaction tools in Microsoft Office and PDF documents.

 One click email protection

As an alternative to the Workshare Protect Email Security dialog, simply click a profile to apply security 
to emails and their attachments.
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 Storage of Attachments in the Cloud

To free users from having to send attachments by email and to facilitate the sharing of files outside of 
email, users can upload attachments to the Workshare platform and send recipients links to the 
documents in Workshare.

 Classify documents

Easily restrict access to sensitive business documents by setting document classifications.

 Detect confidential information

Utilize the Workshare Policy Designer to identify intellectual property or sensitive information such as 
financial data or passwords within email or Office documents.

 Full PDF security

Through policy rules your organization can enforce PDF creation with 128-bit encryption and restriction 
rules.

 Audit and reporting

Track and report every document change made inside and outside of the organization.

What’s New in Workshare Professional 7.5
Workshare Professional 7.5 includes the following new features:

 Faster comparison for DOCX files

The fast comparison previously only available for DOC files is now also available for DOCX files (Word 
documents Office 2007 - 2013). Select Fast as the Comparison Mode when comparing using 
Workshare Compare. To enable this feature, select the Enable fast comparison for DOCX files
parameter in the Workshare Configuration Manager (Comparison > Administration category).

 Improved table comparison

The comparison of tables within documents is enhanced with the Redline showing clear and accurate 
results even in complex areas such as Excel tables within documents, tables with no changes, changes 
to the structure of a table.

 Compatibility with Windows 8 and Office 2013

 Improved Send Link process

The flow of the send link process where the user uploads documents to the Workshare platform and 
sends a link to the document within the platform has been improved so the user experience is less 
convoluted.

 Ability to change the default user location for rendering sets

By default, personal rendering sets are stored in C: Users > (user name) > My Documents > 
Workshare > Rendering. This can now be changed by an administrator by specifying a different 
location for the Default rendering set location parameter in the Workshare Configuration Manager 
(Comparison > Administration category).
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 Ability to display/hide the Add Large Attachment button

Users can select whether the Add Large Attachment button is displayed in email messages using the 
Display Add Large Attachment button (Outlook) parameter in the Workshare Configuration Manager 
(Protection > Send Link category). The Add Large Attachment button enables the user to use Send 
Link functionality to send a link to a large file when it cannot be sent by email. (Administrators may set 
a limit on the size of files that can be emailed to avoid large files blocking Exchange.)

 Detection of Workshare styles

Workshare Protect checks emails and their attachments to see if they include any Workshare styles. 
(Workshare styles are applied to changes in a Redline document.) To enable this feature, select the 
Detect Workshare styles parameter in the Workshare Configuration Manager (Protection > 
Administration category).

 Ability to enable PostScript simulation

Users can turn on the PostScript simulation option in the printer driver using the Enable PostScript 
simulation parameter in the Workshare Configuration Manager (Protection > Convert to PDF
category). This is relevant when converting documents to PDF that include WordArt and semi-
transparent backgrounds.

In addition, over 50 individual change requests have been addressed (see page 11) and many quality 
improvements made.

System Requirements
The system requirements for Workshare Professional 7.5, Workshare Compare 7.5 and Workshare Protect 7.5
are as follows:

Minimum System Requirements Intel Pentium 4 3.2GHz processor

1.5GB RAM 

1GB free disk space 

Recommended System Requirements Intel Core 2 DUO @ 2.2GHz 

AMD Athlon 64 X2 4400+

2GB RAM 

2GB free disk space 

Certified Environments

Workshare Professional 7.5, Workshare Compare 7.5 and Workshare Protect 7.5 have been tested and certified 
in a number of environments. If your environment is not included in the following list, it may still be a compatible
environment. Contact Workshare Customer Support (support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional, Workshare Compare and 
Workshare Protect were certified against, refer to previous versions release notes at 
http://www.workshare.com/resources/user-guides.

Note: Unless otherwise stated, all environments are the English version with the en-us language set.

mailto:support@workshare.com
http://www.workshare.com/resources/user-guides
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Operating System:

 Microsoft Windows 8 (32 bit and 64 bit) + Japanese

 Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French

 Microsoft Windows 7 (32 bit and 64 bit) – default UAC

Note: Windows XP and Windows Vista are not supported in this release.

Citrix:

 Citrix XenApp 6.5 

 Citrix XenDesktop 5.6

When running on the following:

 Microsoft Windows R2 Server 2008 SP1 (64 bit) 

Note: Check with your Citrix vendor about which Windows operating system supports your version of Citrix. 

Microsoft Office System:

 Microsoft Office 2013 (32-bit) + Japanese

 Microsoft Office 2010 SP1 (32-bit) + Chinese Simplified & French

 Microsoft Office 2007 SP3 (32-bit)

Email System:

 Microsoft Outlook 2013 (32-bit) + Japanese

 Microsoft Outlook 2010 SP1 (32-bit) + Chinese Simplified & French

 Microsoft Outlook 2007 SP3 (32-bit)

 IBM Lotus Notes 8.5.3 FP3

Note: The Send Link feature of Workshare Protect is not supported in a Lotus Notes environment

SharePoint:

 Microsoft SharePoint 2010

 Microsoft SharePoint Server 2007

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports your DMS. 

 Autonomy iManage: 

 FileSite 8.5 SP3 Update 5

 DeskSite 9.0 Update 2a

 DeskSite 8.2 SP2 P2a

 FileSite 9.0 Update 2a
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 Open Text: 

 eDOCS DM 5.3.1 COM only (Patch 3)

 eDOCS DM 5.21 CU6

Note: Worldox integration is supplied and supported by Worldox.

Workshare will endeavor to support future service packs of certified environments.

Important Information
 Send For Review – If an error appears “Workshare Protect was unable to process this email” when 

Sending for Review a user is advised to restart Microsoft Outlook.

 Secure PDFs – Workshare Professional is unable to compare secure PDFs or convert secure PDFs to 
DOC format. Secure PDFs are PDF files with security settings configured.

 Licensing – If the product is licensed on subscription basis, one month before your subscription license 
expires, you can choose to receive a popup Expiry Notice on a daily basis. You can configure 
Workshare Professional so that the Expiry Notice is displayed/not displayed as required. For further 
information, refer to the Licensing Workshare Professional section in the Workshare Installation Guide.

 Policies Not Triggered – When emailing password-protected .docx documents, default policies are not 
being triggered. This is due to the Microsoft Word Security Update KB969604.

 Add Large Attachment – When using the Add Large Attachment button to send a link, do not use the 
Advanced Options functionality.

 POP/IMAP – Workshare Professional does not support Outlook when it is configured with a POP or 
IMAP account.

Important Installation Information
 Workshare Professional installs program files to a sub-folder within the Workshare folder named 

Modules.

 Install: A user is unable to install Workshare Professional if Microsoft Windows Installer 3.1 is not 
installed. This can be downloaded from the following location http://www.microsoft.com/
downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C&displaylang=en.

 Windows Vista: For MSI installs the user must have administrative privileges for the Default Mail 
Client.

 Internet Explorer: You must ensure that your email application is set as the default mail program in 
Internet Explorer. In Internet Explorer, select Internet Options from the Tools menu. In the Programs
tab, select your email program (Microsoft Outlook) from the E-Mail dropdown list. If this is not done, 
you will not be able to send a document for review.

 Windows 7: When UAC is set to Default, running the Workshare Professional install displays the UAC 
prompt. You must approve the prompt and Workshare Professional will be installed. Running the 
Workshare Professional MSI silently will fail when UAC is set to Default because the user is not given 
the opportunity to approve the UAC prompt. Therefore for silent installs, disable UAC.
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 VSTO Prerequisite and Installation using MSI Modes: The Workshare Professional 7.50 installer (msi 
and msp) will not check for the presence of the VSTO prerequisite. The installation will proceed without 
this prerequisite but the Workshare Outlook Add-in will not be available causing a loss of the Workshare 
Protect email functionality. If deploying Professional 7.50 using the msi or msp you must first deploy the 
VSTO. This note applies only to Office 2007 (all service packs) and Office 2010 (without a service pack). 
For Office 2010 SP1 and above and Office 2013, VSTO is already installed.

If you have installed any Alpha or Beta builds of Workshare Professional, we strongly recommend that you first 
uninstall them before installing Workshare Professional 7.5.

Installing Workshare Professional 7.5

Workshare Professional 7.5 (Build 16000.600) will uninstall previous versions and can therefore be installed 
without uninstalling previous versions of Workshare Professional. Versions prior to 7 will have their settings 
upgraded; version 7 will not have the settings upgraded.

Known Issues
The following are known issues in the Workshare Professional 7.5 release - for more information, please contact 
Customer Support.

ID Details

12461/
12453

Issues with Foxit PDF Files

PDFs are not supported which are created or edited by Foxit PhantomPDF.

13962 Send Link and Logging In – Windows 8 (x64) Office 2010 SP1/2013

When sending several emails and selecting the Send Link profiles, the user is prompted to log 
into their Workshare account every time. Be sure to validate your Workshare account before 
sending several emails.

14365 Send Link

After selecting a Send Link profile to upload attachments to the Workshare platform, canceling 
the upload process part way through stops the email from being sent but the attachments are 
still uploaded.

14422 Detect Workshare Styles – Windows 7 (x86)/Office 2007 SP3 and Windows 7 (x86) 
SP1/Office 2010

When Workshare styles have been detected in a comparison and the comparison is saved as a 
DOC file, subsequent content risk discovery on the DOC file does not discover the Workshare 
styles.

Note: If the comparison is saved as a DOCX file, the Workshare styles are discovered.

14590 Lost Attachment – OpenText DM 5.3.1 COM Suite Patch 3/Windows 8 (x64)/Office 2010 
SP1

When sending an email with attachments both from the DMS and the local file system, and the 
DMS file is the FIRST attachment, the local file attachment is lost.
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ID Details

14629 Save as Convert to Track Changes Document

The Save As > Save As Track Change document feature in Workshare Compare is not 
working. However, the user can convert a Redline document to a Word document showing the 
changes as track changes using the right-click Convert to Track Changes option.

14656 Sending Emails with DM Profiling – OpenText DM 5.3.1 COM Suite Patch 3/Windows 8 
(x64)/Office 2010 SP1

When DM profiling is selected (File > DM Options, select Profile on Send tab and select
e-mail message before sending e-mail in DM Email Options dialog), sending emails and 
applying a Protect profile, an error is displayed.

14904 Sending Emails via Right-click Option - Windows 8 (x86)/Office 2013

After successfully sending an email using the right-click Send to > Mail recipient option, trying 
for a second time to send an email using the same process, the email window is not displayed 
and the action is not performed.

14910 Workshare PDF Publisher - Windows 8 (X86)/Office 2010

When printing from Word or Excel and selecting Workshare PDF Publisher as the printer, an 
error is displayed.

Change Requests Fixed
The following are fixed customer change requests that have been validated for this release - for more 
information, please contact Customer Support.

Compare

CR # Description

00165749 Professional 7.00 - Missing deletion in table comparison

00165858 Professional 7.00 - Incorrect use of padding cells in table comparisons

00165940 Professional 7.00 - Table rendered off the page after table comparison

00166342 Professional 7.0 - Ability to Change Default Save Location for Rendering Sets

00167285 Attempting to edit redline first saved as PDF results in Failed to run Act on Changes error

00165749 Professional 7.00 - Missing deletion in table comparison

00165856 Professional 7.00 - Incorrect insertion in table comparison

00165857 Professional 7.00 - Incorrect use of merged cells in table comparisons

00165940 Professional 7.00 - Table rendered off the page after table comparison

00171889 Professional 5.2 SR3 - Missing text in comparison of manual list items

00168918 Professional 7.00 FP1 - Numbering insertion not showing when using 'Convert to Track 
Change Document'
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CR # Description

00168256 Professional 7.00 - Compare loses focus when comparing documents stored within DM 5.3

00177284 Professional 7.0.0 + FP2 - PDF Button on Compare ribbon does not function when 
comparing documents from Desksite

0011129 Workshare 5.2 - "Huffman symbol not found in JPEG read" error when comparing docs with 
Optimized JPEG

00171968 Professional 7.00 FP1 - Request for Complete Display of Lowercase Letters

00182505 Professional 7.00 FP3 - Table is shifted in saved redlines when source documents created 
with MacPac "memo" template

00177939 Professional 7.00 FP3 - Email signature not added when emailing from Compare or Word

00160628 Professional 7.00 - Tooltip showing redline document names missing in Compare

00172911 Professional 7 + FP1 - "Only print pages with changes" option causes extra pages when 
printing documents with page breaks or section breaks

00114678 Workshare 5.2 SR1 - Unable to save the redline as a version to either source document in 
Interwoven

00111812 Workshare 5.2 SR1 - Incorrect comparison of Japanese documents is shown when saved as 
DOC or PDF format

00095254 Workshare 5.1 - Comparing unsaved documents in Office 2007 prompts to save locally and 
not in the DMS

00094353 DeltaView 3 - Act on Changes does not show documents in columns

00093743 Workshare 5.1 - Fail Safe Mode does not work when comparing PDF files

00068366 Workshare 4.5 SR1 - Document formatting is incorrect when compared in DeltaView

00171579 Professional 7.00 FP1 - FP1 Replaces '#' with '_' when Appending Document IDs to Default 
Filenames

00165808 Professional 7.00 - Grey panel is displayed in TER view when comparing documents that 
contain a text box that is 11.9cm or more from the right of the page

00163698 Professional 7.00 - Dotted lines around changed images do not appear when redline 
converted to PDF

00124048 Workshare 5.2 SR2 RC - WDF and WWB file types do not have registered icons

00103245 Professional 5.2 SR1 - Swap button in the Document Selection window doesn't work if only 
one document selected

00172058 Professional 7.0.0 + FP1 – Tables In Footnotes Are Incorrectly Displayed In TER

00159207 Professional 5.2 SR3 - Document numbering is displayed incorrectly when comparing 
documents within Word

00147059 Professional 5.2 SR3 - Document Headers are not displayed correctly within TER

00142388 Professional 5.2 SR3 - TER view shows incorrect table formatting if table width exceeds the 
page margin width
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CR # Description

00179022 Professional 7.00 - Unable to compare PDF documents generated by MS Project 2010

00177577 Professional 7.00 FP2 – Tables are incorrectly rendered

00148595 Professional 5.2 SR3 - WinWord Freezes when attempting to email redlines from within 
Compare

00174026 Professional 7.00 FP1 - Workshare Interwoven save as dialog does not appear when saving 
comparison into DMS

00178446 Professional 7.00 FP2 - Document numbering is rendered incorrectly when comparing 
documents with MacPac numbering

00174578 Professional 5.2 SR3 - PDF comparison results in poorly formatted redlines in TER

00177506 Compare Server 5.2 SR3 - Text in the header or Footer cannot be compared

00178844 Professional 7.00 FP3 (15000.1000) - Bookmarks in Modified Document Not Present in 
Redline

00179143 Professional 7.00 FP3 - Document bookmark _ljs_searchstart causes sections of the redline 
to not be rendered

00181558 Professional 7.00 FP3 - Text Duplicated in Redline

00182810 Professional 7.00 FP3 - Unexpected exception when attempting to compare SharePoint 
documents in Word

00182246 Compare 7.00 FP3 - Text missing from second-level numbering in redline

00183008 Professional 7.00 FP3-- Redline statistics page is printed on A3 paper

Protect

CR # Description

00175053 Professional 7.00 FP2 - Attachment is renamed when forwarding emails both internally and 
externally

00179105 Professional 7.0 FP2 - Content Discovery Fails when sending Word Document with Empty 
Custom Property

00169830 Professional 7.0 FP!- Text Incorrectly Displayed In The Document When Creating PDF Using 
"Send as Comparison Document" Option In Workshare

00172477 Professional 7.00 FP1 - First DOC/DOCX Attachment Opened on Each Launch of Outlook Not 
Read-Only

0096242 Workshare 5.1.1 - Message files with embedded Word 2007 docx documents are becoming 
corrupt during send and clean with Workshare Professional.

00140938 Professional 5.2 SR3 - 30 Second delay when sending an email for the first time of opening 
Outlook

00175824 Progress Bar not displayed when clicking Advanced Options link from Protect Simple
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CR # Description

00178089 Professional 7.00 FP3 - Request to configure the display of 'Add Large Attachment' button

00173388 Professional 7.00 FP1 - "Document discovery failed" error when Batch Cleaning/Sending via 
Protect

00164132 Professional 7.00 - Error in Action when sending any .DOC file with color background and 
white text Table of Contents

00149772 Professional 5.2 SR3 (9800.2400) - Second Word Session Opened from PES Preview Closes 
after Send

00152657 Professional 5.2 SR3 (9800.2400) - Sending HTM files causes Protect to freeze

00151689 Professional 5.2 SR3 (9800.2400) - Batch Clean Does Not Remove Comment Indicators in 
Excel Files

00147574 Professional 5.2 SR3 - Could not complete the operation error creating Outlook Notes

00141284 Workshare 5.2 SR2 - Unable to preview protected documents from the Protect dialog box

00121075 Workshare 5.2 SR1 - White text and/or small text will not be cleaned from within a text box 
if more than one text box exists in a document

00180771 Professional 7.00 FP3 (15000.1000) - Canceling Protect Results in Two Outlook Prompts 
when Closing Outlook

00109133 Workshare 5.2 SR1 Beta - Outlook Runtime Errors

00105945 Workshare 5.2 - Track Changes should be turned off in the cleaned document after 
removing track changes

00099396 Workshare 5.2 - Document Statistics are not cleaned from a .doc file when sending via 
email

0019017 Protect Premium 6.1 - Track Changes is greyed out on the email dialog when sending a 
PowerPoint file as the last attachment

00089361 Workshare 4.5.2 - Disabling the PDF buttons in Excel and PowerPoint also removes the 
Toggle Panel button.

00175744 Professional 5.2 SR3 - Stellent Outside In splash screen appears when emailing images 
externally

00173330 Professional 7.00 + FP1 – Alternate class name populates PDF as default class when 
saving a document as PDF

00163438 Professional 7 - "Error in Action" error when sending and cleaning blank XLS spreadsheet

00173363 Professional 7.00 + FP1 - Unable to send encrypted password PDFs 

00177776 Professional 7.00 FP3 - Unable to open NRL attachments from open emails

00178600 Professional 7.00 FP2 (10000.5700) - "Create and View" button shows incompletely when 
font DPI setting changed to Medium 125%

00180167 Professional 7.00 FP2 - Outlook hangs then crashes when browsing through emails

00179989 Professional 5.2 SR3 – Error: Word cannot open the file because the file format does not 
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CR # Description

match the file extension.

00180572 Professional 7.00 FP3 - Graphic and text missing from PDF conversion

00180418 Professional 7.00 FP2 (10000.5700) - Error: Content discovery failed when Sending PPTX 
Files with Certain SmartArt

0096242 Workshare 5.1.1 - Message files with embedded Word 2007 docx documents are becoming 
corrupt during send and clean with Workshare Professional.

00179853 Professional 7.00 FP2 (10000.5700) - Error: Content Discovery Failed when sending XLSX 
file with =# Formula

00180335 Professional 7.00 FP3 - Request to hide the 'Add Large Attachment' button

0017445 Professional 5.2 SR3 - Error occurred while executing Clean action for the file

00179916 Professional 7.00 FP2 (10000.5700) - Error: Content Discovery Failed when sending XLSX 
file with Filtering and Functions

00171633 Professional 7.00 FP1 - Outlook crashes when processing certain PDFs with Protect

00177735 Professional 7.00 FP3 - Cannot open file when opening MSG for second time

00181327 Professional 7.00 FP3 - Protect Does not Discover or Clean Small Text with Font Size 1.5, 
2.5, 3.5, 4.5

00182905 Professional 7.00 FP3 - Delay in population of email sender in 'From' field

00182746 Professional¦ 5.2 SR3 - Data in Headers and Footers is removed when Document is Cleaned 
if the Delete Hidden Text option is selected

00182908 Professional 7.00 FP3 - Password-protected Word documents sent through Protect do not 
convert to PDF if password is not provided

00179105 Professional 7.00 FP3 - Content Discovery Fails when sending Word Document with Empty 
Custom Property and Send For Review Properties

00183613 Professional 7.00 FP3 - Unable to check in checked out emails back into FileSite

00146773 Professional 5.2 SR3 - Email signature image is added to email as an attachment after being 
cleaned by Workshare

00164226 Professional 7.00 - Page numbering is set to "1" when field codes are cleaned using Protect

00178610 Professional 7.00 FP2 - Convert to PDF page ranges are retained even when selecting to 
print the entire document

Review

CR # Description

00124046 Workshare 5.2 SR2 RC - PDF Combine encounters an error if no 'Save As Type' defined

00175695 Professional 7.00 FP2 (10000.5700)- PDF documents with filenames containing Unicode 
characters cannot be opened using 'Open in Word with Workshare' option
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00171694 Professional 7.00 FP1 - Send for Review process fails when choosing PDF as the email 
attachment file type

Other

CR # Description

00163552
00164309

Professional 5.2 SR3 - Ability to add Workshare buttons to out of the box Ribbons in Word

00111974 Workshare 5.2 SR1 - Workshare Ribbon not present in Excel 2007 for non-admin user

00176363 Professional 7.00 FP2 (10000.5700) - Workshare Panel in Word is Disabled if Word is 
Closed using File > Exit

00183354 Professional 7.00 FP3 - Right-click context menu entries missing in FileSite after running 
WCA

00165979 Professional 7.00 - When Workshare Panel is toggled On, opening multiple Excel 
spreadsheets shows reduction in size and unexpected overlapping

00128221 Workshare 5.2 SR2 - The Workshare Toolbar is floating instead of docked in Word when 
replacing Workshare menu with the Toolbar

00168801 Professional 5.2 SR3 – Company Logo Is Misplaced In Workshare 

00128120 Professional 7.00 FP3 - Ability to customise Workshare Ribbon

00173365 Professional 7.00 FP1 - Log into server prompt when opening document using Portable mode

00157936 Professional 5.2 SR3 - Ability to indicate a pre-requisite download failure

00114838 Workshare 5.2 SR1 Worksite icon is removed from outlook when uninstalling WPro 5.2 SR1

00157936 Professional 5.2 SR3 - Ability to indicate a pre-requisite download failure
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Contact Info
For technical help and support on Workshare products, contact Workshare Customer Support:

support@workshare.com 
EMEA: +44 207 539 1400 
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090

Workshare Ltd.
20 Fashion Street
London E1 6PX
UK

Workshare Inc. (USA)
625 Market Street, 15th Floor
San Francisco
CA 94105
USA

Workshare Ltd.
Level 56, MLC Centre
19-29 Martin Place
Sydney 2000
Australia


